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Extraction of a digital elevation model from ASTER Level 1A 

stereo imagery using PCI Geomatica OrthoEngine® v.8.2.0

This document describes the process of producing a Digital Elevation Model (DEM) from ASTER (Advanced Spaceborne Thermal Emission and Reflection Radiometer) data. It relies on the inherent parallax between stereo pairs of images. An automated image correlation algorithm is used to derive relative elevations from the parallax, given a set of well-located tie points (TPs) and the satellite ephemeris. Absolute elevations can be determined if suitably accurate ground control points (GCPs) are also available. In both cases a geocoded product can be made.

The procedure is adapted from that used at the United States Geological Survey Earth Resources Observation Systems (EROS) Data Center as described to me by Glenn Kelly (kelly@usgs.gov) and Penny Weeks (pweeks@usgs.gov). The software package used is OrthoEngine® v.8.2.0, part of the Geomatica® desktop photogrammetry suite developed by PCI Geomatics (http://www.pcigeomatics.com/). Dell® workstations running Microsoft Windows 2000® were used in testing the protocol at Caltech.

OEMs extracted with this technique are comparable (if not identical) in quality to those obtained from the EROS Data Center via the Earth Observing System (EOS) Data Gateway 

(http://edcimswww.cr.usgs.gov/pub/imswelcome)
1. Introduction

ASTER (http://asterweb.jpl.nasa.gov/) is a high resolution, multispectral/hyperspectral instrument on board the Terra spacecraft, the first satellite in the Earth Observing System constellation (http://eospso.gsfc.nasa.gov). ASTER takes data in 14 spectral bands within the Visible and Near Infrared (VNIR), the Shortwave Infrared (SWIR), and Thermal Infrared (TIR), at ground resolutions of 15 m, 30 m, and 90 m, respectively. The Terra spacecraft operates in a sun-synchronous orbit with a ground target acquisition time of 10:30 am (local) and a 16-day recurrence cycle.
For application to stereo imagery and DEM production, the VNIR subsystem consists of two independent telescope assemblies: one nadir- (straight down) and one backward- (aft-viewing along orbit, 27.6° off-nadir) looking. The two telescopes allow simultaneous (ca. 64 seconds latency) imaging of the ground target with the appropriate parallax and image overlap for along-track stereo. This also ensures that the atmospheric conditions between the target and the instrument, as well as the illumination and radiometric characteristics of the ground cover, are as close to identical as possible between the two images. This significantly improves the success of image correlation, which is key to extracting elevations. The nadir- and backward-looking images are in the 0.76-0.86-|im band, and are herein referred to as bands 3N and 3B, respectively. Taken at an altitude of 705 km, with a B/H of 0.6, 3N and 3B have an instantaneous field of view (IFOV) of 15 m/pixel and scene dimensions of 60 km x 60 km. Several different types of ASTER data are available and are differentiated on the basis of processing level. They are classified according to a "data product level" label see: 

http://asterweb.jpl.nasa.gov/products/data_products.htm
http://edcdaac.usgs.gov/aster/asterdataprod.html
http://eospso.gsfc.nasa.gov/atbd/astertables.html 

For instance DEMs obtained from the EROS Data Center are Level 4 data. For our purposes here, one should be aware of Level 1A and Level IB data. Level 1A data has had the least processing applied to it. It includes the image data (radiance at the sensor in unitless "digital counts") for each of the 14 bands in the scene (separated by telescope) with the radiometric and geometric coefficients appended but not applied. The radiometric coefficients are necessary to calibrate the radiance to units of W m"2 |im"2 sr"2, and the geometric coefficients are used in the coordinate transformations for band-to-band coregistration and for scene geocoding. Level IB data has both the radiometric and geometric coefficients applied. Level 1A is the preferred input data for the DEM extraction, although anecdotal evidence suggests that Level IB data also yields acceptable results.
The conceptual basis for DEM extraction is fairly simple (see the links at the end of this section for mathematical details and references to published papers). The generation of the DEM first requires that the stereo pair of images be registered to the same ground area. This is done by the use of TPs and/or GCPs. Once registered to the same ground area, any along-track (in the direction of the satellite's travel in its orbit) positional differences are assumed to be due to parallax. The parallax, in turn, is assumed to be due to topographic relief. Measured parallax differences on a pixel-by-pixel basis can then be converted to relative (or absolute) elevations using trigonometry and the satellite orbital data (ephemeris, orbital position, altitude, and attitude). The difficult part is the "pixel-by-pixel" as it requires an automated way to correlate the millions of pixels in one image to those in its conjugate.
Selection of TPs informs the software explicitly of manually selected pixels in the 3N image that correspond to manually selected pixels in the 3B image. Selection of a sufficient number of well-distributed TPs results in a set of coefficients (and root mean square error) that defines a mathematical model (and its accuracy) for the relationship between any pixel in the 3N image and its conjugate in the 3B image. According to the EROS Data Center and my own experimentation, at least 9 TPs are needed for good results. They should be evenly spaced in the scene in both planimetry (x-y) and elevation (z). Diminishing returns in terms of time and quality of the product occurs with more than ca. 25 TPs. Stereo GCPs (the same GCP collected on both the 3N and 3B images) serve the same purpose as TPs, and they simultaneously serve as absolute elevation and latitude/longitude constraints (for more-precise georeferencing, as do non-stereo GCPs). At least 4 stereo GCP pairs are recommended for best results, according to PCI (with diminishing returns — e.g. don't bother to collect hundreds!). Note that GCPs are not required if TPs have been collected. However, without GCPs, the resulting DEM is a relative DEM since absolute planimetric and elevation data is not provided by TPs.
The coefficients in the mathematical model are used in transformation equations that convert the right-hand image of the stereo pair (image 3B) into an "epipolar" image that is conjugate to the left-hand image (3N). In making an epipolar image, the 3B image is "reprojected" (e.g. warped) to minimize cross-track offsets relative to the reference image (image 3N). Thus, the offsets in image-to-image registration between the 3N image and the epipolar 3B image are due to along-track differences. These parallax offsets, as mentioned earlier, are assumed to be due to relief. The elevation information contained in the epipolar pair is therefore useful for both DEM extraction and 3D visualization (e.g. anaglyph, etc.).
With the model coefficients and the epipolar image having been computed, the 3N and 3B images must then be matched to establish parallax values on a pixel-by-pixel basis using an image correlation algorithm. Before beginning, the maximum terrain relief expected in the image is specified as well as the vertical datum. A correlation window of specified size is centered over a pixel (call it A) in the 3N image. In the epipolar 3B image, a search window — of size corresponding to the parallax displacement (in pixels) defined by the maximum expected relief in the scene — defines the area in which the pixel conjugate to A is expected to be found. The correlation window is then moved pixel-by-pixel across the search window and a correlation coefficient is computed at each location. The pixel in the epipolar 3B image with the maximum correlation coefficient is chosen as the matching pixel corresponding to A in the 3N image. The along-track difference between the pixel locations in the two images is taken to be the parallax value from which the relative elevations are computed. This process is repeated for the entire scene to produce the DEM.
Some pixels will fail due to lack of correlation (due to excessive shadowing, large swaths of uniform albedo, etc.). The resulting DEM must then be edited to remove failed pixels and anomalous elevation values using the masking, interpolation, and filtering algorithms built-in to OrthoEngine. The final step is to geocode the DEM based on either the ephemeris data alone (relative DEM) or using the GCPs (absolute DEM). It must be reiterated, that while the elevations in the relative DEM case are reasonable representation of relief, they are not true heights. For instance, in addition to uniform elevation offset, there may be regional tilt, etc. that is unaccounted for in the relative DEM.
Total estimated time of production for a single DEM from a single raw Level 1A ASTER scene is ca. 3 hours, although this is clearly dependent on the hardware used. Specifically, a single-processor 1.5 GHz Intel Pentium 4® system with 0.5 GB of RAM can complete the automatic image correlation in ca. 1 hour. For comparison, dual processor systems at the EROS Data Center can do it in 30 to 45 minutes. In addition to the ca. 1 hour of automatic processing time (which can fortunately be queued to be done during off-hours for efficiency), ca. 1 hour of pre- (project setup and TP/GCP collection) and ca. 1+ hour of post- (editing and geocoding) processing is needed.
According to the ASTER team, the resulting OEMs are useful for mapping at 1:100,000 to 1:250,000 scales. Also based on the ASTER team's specifications (see links below), the estimated horizontal Root Mean Square Error (RMSE) in planimetry (x-y) is ca. 50 m, and the vertical RMSE in elevation (z) is ca. 10m to 30 m for a relative DEM and 7 m to 50 m for an absolute DEM. The latter z RMSE is highly dependent on the quality of GCPs. Both estimates of z RMSE are dependent on the accuracy of manually selected TPs and the outcome of the automatic image correlation. DEM resolution in z is ca. 1 m, whereas x-y resolution is 30 m. Note that the planimetric resolution of the input image data is 15 m.
I note with caution, however, semi-quantitative, preliminary comparisons I've done between 30-m ASTER-derived OEMs, the 30-m USGS 7.5" OEMs, and the new 30-m SRTM OEMs for a portion of northern Death Valley. These comparisons involve simple differencing between the three datasets. The residuals suggest potential elevation and/or georeferencing problems with ASTER-derived OEMs versus the other datasets. In addition, known georeferencing issues exist with ENVI® image analysis software; ENVI (as of version 3.5) apparently does not correctly read the ephemeris-derived geocoding data in the ASTER HDF file. It should be understood, however, that the geocoding done by OrthoEngine is not very accurate anyway since the ephemeris-derived corner points used are themselves only accurate to ca. 300 m at best. Note also potential confusion with regard to the projection/datum of the ephemeris-derived geocoding: some documentation says it is always UTM/WGS84, although some documentation states that continental United States scenes are in UTM/NAD83.
More detailed information on the "AST14 Digital elevation model" data product available from the EROS Data Center can be found at the following sites:
http://asterweb.jpl.nasa.gov/products/DEM.PDF
http://edcdaac.usgs.gov/aster/ast14dem.html
http://eospso.gsfc.nasa.gov/ftp_ATBD/REVIEW/ASTER/ATBD-AST-08/atbd-ast-08.pdf
2. Project Setup

a.
Select the appropriate ASTER level 1A scenes you wish to work with. Make sure the files have a *.hdf file extension. If they don't, add the extension manually.
b.
A good way to organize your project is to give each DEM extraction a separate directory. Later on, you will save the OrthoEngine project file at the top level of this main directory.  Within the main directory make three subdirectories: raw, pix, and dem. Place the raw ASTER HDF files in the raw folder.
c.
Start OrthoEngine. The main OrthoEngine window will appear.   The program is well designed in terms of workflow. It is organized as a series of panels, navigable via the Processing   Step pull-down menu. Each processing step panel has a different series of buttons. Pointing the cursor at a button will show a description of what it does at the bottom of the main OrthoEngine window. Pushing a button brings up a corresponding dialog box wherein the work gets done. In general, a project progresses through the processing step panels in order (top-down), and through the buttons in each panel (left-to-right), although it is not necessary to do all the processing steps or buttons (it depends on what you are trying to do). In addition, there are four "global" pull-down menus at the top of the OrthoEngine window that provide (mainly) file-management utilities and online help. Online help (and the printed manuals) are of only limited usefulness, although they do give the basic idea of what's going on if you are lost.
d.
Select File - > New. This will start the process of making a new project.
e.
In the Proj ect Information dialog box that appears, enter a filename (you may have to browse the filesystem to select the appropriate path). You may also enter a project name and description. The project name is displayed at the top of the main OrthoEngine window while you are working, so it is handy to include useful information in the name (date, ASTER scene numbers, etc.)
f.
Click the Satellite Orbital Modelling radio-button in the list on the lower left side of the dialog box.
g.
Select the General   High   Resolution option that should now be available on the lower right side of the dialog box.
h. Press the Accept button to proceed. The Set Projection dialog box should appear. If not, just press the corresponding button that should be visible in the main OrthoEngine window. Note that you can similarly go back and change what you did in the Proj ect Information dialog box (or any dialog box in any processing step) by pushing the appropriate button. Use caution when making changes to previously completed processing steps as some changes made to the project may invalidate any processing you may have already done to your images.
i. In the Set Proj ect ion dialog box, set the output projection to UTM via the pull-down menu. A list of UTM zones will appear in a second dialog box. The UTM zone is determined by the latitude and longitude of the scene center point. An easy way to find out the scene centerpoint coordinates is to use the HDF Explorer program (http://www.space-research.pt/). With HDF Explorer, open the raw ASTER HDF file and view the product metadata. 0 listing. At the end of the listing, there should be a series of coordinates, one of which is the latitude (north is positive) and longitude (east is positive) of the scene center point. Use this information to pick the appropriate UTM zone and push the Accept button to continue

j. Push the Earth Model button to bring up a list of models; select WGS84 for scenes outside of the continental US and use NAD83 for scenes within the continental US.
k. Set the Output Pixel Spacing to 15 m, the ground resolution of the ASTER VNIR bands.
1. Note that although not specified explicitly, the elevation units are set to meters. This can be changed if necessary (not recommended) under the Options menu.
m. Finally, push the Set GCP Projection based on Output Pro j ect ion button if there are no GCPs to be used. If there are GCPs, the GCP Projection parameters are set based on the projection of the GCP data. When finished, push the Accept button.
n. Now select File - > Save to save the project. Save the project frequently while you work as OrthoEngine can crash unexpectedly. Also note that a project backup file is made automatically and is updated every 15 minutes. It is given the same name as the working project file, but with the *. bk extension. Backups can be controlled via the Options menu.
3. Data Input and File Management

a.
From the pull-down menu in the main OrthoEngine window, choose the Data Input processing step panel. In this step we will import the ASTER HDF files in your raw directory, read the scene ephemeris data, read in the imagery, and convert the data to OrthoEngine's native file format (*.pix).
b.
Choose the Read CD-ROM Data button. The Read CD - ROM dialog box should open.
c.
Select ASTER from the CD Format pull-down menu.
d.
Browse the filesystem (using the Select button) and choose the ASTER HDF file you have in your raw directory as the CD Header Filename.
e.
Beside Requested Channels will be 14 labeled buttons corresponding to the 14 ASTER bands. We need two of these, 3N and 3B. Since we need them in different *.pix files, we have to do this part twice, however.
f.
Push the button for band 3N. Under Data   Output, enter the PCIDSK Filename (the name of the *.pix file you want to make). Make it simple, like scenenumber_3N.pix, where "scenenumber" is whatever designation you use to keep track of your ASTER scenes. Make sure you include the complete path to the directory where you want the *.pix file to be saved (the pix directory you made) Enter an appropriate Scene Description if you want. Also specify a Report Filename (use the same name as the *.pix file, but with the *. rpt suffix).
g.
Push the Read button to read the 3N band and make the *.pix file.
h. Don't push Close yet. Go back to step "g" and do the same, this time for 3B.
i.   Now push Close.
j.   Save the project.
k. Orthoengine is capable of handling multiple, contiguous ASTER scenes at once by stitching them together, although the larger 3B and 3N images this stitching creates will increase the processing time. To use this functionality, follow the above steps a-j for each of the ASTER HDF files in your raw directory. Once the 3N and 3B bands from each of your scenes is individually read and made into separate *.pix files, you can stitch them together using the Utilities -> Stitch Image Tiles command. Select ASTER in the dialog box that appears. Note that you can choose up to 5 images to stitch together. Stitch all the 3B images together and save the result to a new *.pix file. Do the same for 3N. You will be asked if you want to add the new composite 3B and 3N images to the project and remove (but not delete from the hard drive) the individual, single-scene files. Say Yes when prompted and proceed. From this point, you will only deal with the composite 3B and 3N images. They are treated just like single-scene 3B and 3N images. 1. Note that OrthoEngine pays close attention to where files are and what they are called and will not be happy if things are moved or renamed. If you move, remove, or rename an image file belonging to the OrthoEngine project, you need to update the project to reflect the change. Do this using the Remove Image/Photo and Rename Image/Photo options listed under the Utilities menu. Make sure you save the project after changing image file locations and/or names with these utilities. Note that if you did not enter in the complete path (or used an incorrect path) when naming your *.pix files in step/above, you will have to move the files and update the project. The first place to look for misplaced files (in the event you didn't specify the path) is (somewhere) in the Geomatica program directory.
4. Tie Point and Ground Control Point Collection

a.
Select the GCP/TP Collection processing step.   What you do here depends on if you have only tie points (TPs), or both ground control points (GCPs) and TPs. The two procedures we are mainly concerned with are Collect GCPs Manually and Collect Tie Points. Automatically Collect Tie Points is worth trying, but it does not always work well - your mileage may vary, though.
b.
Whichever TP or GCP collection method you use, you need to open the images you want to work with.  Click Open a New or Existing Image. The Open   Image dialog box will appear showing a list of available uncorrected images belonging to the project. Use the Quick Open option for both 3N and 3B. When the image windows appear, you can close the Open Image dialog.
c.
The image windows are resizable, and have several buttons at the top. At far right is a button that shifts the field of view in the window such that the point currently selected by the red crosshair is in the center. Next is a toggle button for specifying the Working and Reference images. You can toggle between the two to choose which image is the reference and which is being referenced. Only one image can be the Reference (and you need to have at least one). In general, though, you can have multiple (one or more) Working images. For ASTER, however, you will only   have one Reference and one Working image (the 3N and 3B images). Next is a pull-down menu for controlling the contrast stretch. Only a limited number of contrast stretches
are available; experiment with them to see how they work. Note that the stretch is reapplied every time you zoom in or out. The "Hold" option will force the stretch to remain the same throughout zooms. Next are two magnifying glass buttons for zooming in and out, and a pull-down menu for
quickly selecting a specified magnification. The last button (with the zig-zag arrow) can be ignored (it does something or other with vectors). Automatically Collect Tie Points (you can skip this if you want). This will use the image-correlation algorithm to do exactly what you will do manually in the Collect Tie Points step. The default number of points to collect is 9 (it usually falls short of that number), with a matching threshold (measure of match confidence) of 75%. Type an approximate elevation (in meters) that is somewhere in the middle of the image elevations in the scene. You can also choose how the TPs are to be distributed (the near-complete overlap between the 3N and 3B images, however, makes the two available options essentially equivalent). You can also set the processing time to begin immediately or at a later time, although my experience is that this process is fairly quick (a minute or so). Click Start Auto Tie Point Matching and say Yes when asked. When it's done, do some quality control on the tie points it collected, as they are usually not quite right. The tie points can be modified in the Collect Tie Points step, though. Collect Tie Points (required) Turn off Auto Locate, as it gets quite irritating. Turn on Bundle Update so it will update the RMSE of the model as you go. If you did the Automatic Tie Point Collection, there will already be TPs in the Accepted Tie Points list. If you didn't do it, you'll have a clean slate. The Reference image window will have a new button that says Make TP; Working images don't have this button.
a.
To create a TP, find an easily identifiable point on the Reference image that can be identified on the Working image. Do this as precisely as you can (like within a pixel), at a reasonably high magnification (like 8x or 16x). What works best is to pick the corner intersection of four pixels as the match point.
b.
Once you have the red crosshairs on the match point in both images, zoom both images to the maximum (128x) and place the crosshairs at the exact intersection (just to be sure). Then click the Use as TP in the Working image window to set that point at the TP. Note that the button is only available when the zoom is set to at least Ix.
c.
A label will appear next to the selected point and the image coordinates (in pixels) of the selected point will be displayed under Working Image Tie Points in the dialog box. Note that you can add uncertainties (in pixels) to the image coordinates if you choose. You can also change the Tie   Point   ID (not recommended as they must be unique to each pair) and add an Elevation with uncertainty (if that information is available).
d.
Once the TP is selected in the Working image, a Use as TP button appears in the Reference image. Click it to complete the TP pair. The image coordinates of the point in the reference image are added to the Reference Image Tie Points list.  You can change one or both of the selected points by moving the cross hairs somewhere else and clicking Use as TP buttons again, etc. When you are satisfied with the TP pair click Accept.
e.
When accepted, the TP pair is moved to the Accepted Tie Point list and the RMSEs are re-computed. You can sort the list of Accepted Tie Points by Residual (click on the appropriate column in the table) to identify problematic TPs (ones with high errors that degrade the quality of the mathematical model). To change or delete an accepted TP pair, highlight it in the table, and it will be made active in the Working image. You can then move, edit, or delete it as you would a newly created TP.
f.
You can continue collecting TPs by repeating steps a-e. Periodically save the project as a precaution. When finished, press Close.
g.
Collect at least 9 TPs. Arrange them in a 3 x 3 lattice pattern such that they are evenly distributed around the edges of the scene, with adequate coverage of the corners and edges. Try to also distribute them evenly in elevation. Try to keep the TP residual errors as low as possible (below 2 is ideal).
f. Collect GCPs (required for absolute DEMs). If you have GCPs, you can add them to the project either before or after collecting TPs. The concept and procedure (and dialog box) are similar to those for TPs, but GCPs are a bit more complicated since they provide georeferencing. An important thing to note is that a GCP is typically collected for a single image - all you are doing is assigning a specific, real-world position to a given pixel. You can, however, just as easily simultaneously collect the same GCP on two (or more) open images. Moreover, if you are collecting the same GCP on multiple images and if you give the GCP the same ID number on each image, the points you collect are called stereo GCPs. Stereo GCPs have the same image correlation functionality at TPs in addition to providing georeferencing. For our purposes, you should collect stereo GCPs.
a.
Selecting the pixel to use as the GCP is essentially the same as for TPs. You select the point on the Working image only and push Use as   GCP. Make sure to turn off Auto Locate and to turn on Bundle Update.
b.
Once selected, the pixel coordinates of the selected point are shown under Image Position. You can add uncertainties if necessary.
c.
Under Georef erenced Position (the GCP projection is also displayed), you must enter the elevation (required) and real-world coordinates (and uncertainties if necessary) of the point you selected in the Working image. Once entered, the coordinates (in UTM) will be
converted automatically to latitude/longitude. Note that under Auxiliary Information, you can choose a DEM file for the area you are working with from which to extract elevations based on the coordinates you enter. Be sure that the GCPs and the DEM are in the same projection or they won't refer to the same location! Note
also that the GCP projection must be specified in the project setup (and not just simply set to the output projection).
d.
The GCP position in the Working image can be adjusted by clicking a new point and pushing the Use as GCP button. Make sure you are happy before pushing Accept. In order to change the location of an accepted GCP in the Working image, you must highlight it in the Accepted Points list, delete it, recollect it, and re-enter the georeferencing data. If you only wish to re-enter the georeferencing, you simply have to highlight the GCP of interest and edit the appropriate fields in the dialog box.
e.
GCPs in the Accepted Points list can be sorted by Residual. In addition, the total RMSE (in either pixels or ground units e.g. meters) for the mathematical model is shown. Minimize the RMSE as best as you can (below 2 is best). Note that unlike TPs, GCPs have the
capability of being set as Check Points (CPs). CPs are not considered in the mathematical model. Using this, one can systematically remove or add GCPs from the model without deleting/recollecting them in order to evaluate the quality of the model. You can specify whether a GCP is a CP or not by using the pull down menu under Point ID.
f.
Continue collecting GCPs following steps a-d. Remember that stereo CGPs need to have the same ID number (edit it manually as you collect the CGP pairs) in both the 3B and 3N images. Save the project periodically as you go. Push Close when finished collecting GCPs.
g.
Note that another useful way to collect GCPs is to use the Collect GCPs from Geocoded Image option, the mechanics of which are similar to steps a-d above. With this option, you can collect GCPs (stereo or otherwise) using your unconnected imagery as Working images and a separate, pre-geocoded image as the Reference
image. The Reference can be a SPOT image, a digitized map, etc. GCP ground coordinates are determined based on the latitude/longitude of point selected on the geocoded Reference image. Elevations (required) can either be entered manually or based on a similarly pre-geocoded DEM (see step c). Note that the geocoded
Reference image and the DEM must be in the same projection. Note also that the GCP projection must be specified in the project setup (and not just simply set to the output projection).
g. A useful tool to use to evaluate the quality of the mathematical model can be found in the Reports processing step. Click on the Residual Report button. It gives a complete report on the RMSEs for the project.
h. When finished collecting TPs and/or GCPs, you can close the image windows. Note that you can go back and add more or change existing TPs and GCPs, but be aware that any changes will invalidate any subsequent processing (e.g. epipolars, OEMs) you may have already done.
i. Choose the Model Calculations processing step from the pull-down menu and click the Perform Bundle Adjustment button that appears. This ensures the mathematical model based on the TPs and GCPs is up to date. Save the project.
5. Epipolar Image Creation

a.
Skip to the DEM from Stereo processing step.
b. Click the Create Epipolar Image button.

c.
The dialog box will show the uncorrected images available to the project in a list under Left Image. Highlight the 3N image. The 3B image will be placed in the list under Right Image; click on it so it is also highlighted.
d.
OrthoEngine will automatically assign filenames to the epipolars based on the image files used to create them, putting an e (for epipolar) and an 1 (for left) or an r (for right) in front of the source filename. The epipolars are created in the same directory as the source files (your pix directory).
e.
Click Create to start the process, and say Yes when asked. It will take a few minutes to make the epipolars.
f.
When the epipolars are finished, save the project.
g.
A cool way to check the epipolars is to skip to the 3-D   Operations processing step and click the 3 -D Feature Extraction button to view the scene in 3-D using anaglyph (red-blue) stereo glasses. The dialog box will be divided in two halves. The left half will have clickable crosshairs
representing the center points of the 3N and 3B images. Click on the one for the 3N image. It will turn red (the 3B centerpoint will turn blue) and a red outline of the 3N image will appear with a label. The crosshairs and outline will also appear the right side of the dialog; on that side, click the blue crosshair, and the 3B image outline will appear in blue along with a label. In the lower part of the dialog box will be two radio buttons, one to select the uncorrected 3B image and the other for the epipolar 3B image as the stereo complement to the uncorrected 3N image. Choose the epipolar for stereo viewing. Select Anaglyph stereo mode from the pull-down menu and click the Load   Pair button.  In the window that appears, you will see the
anaglyph 3-D representation of the ASTER scene. With the glasses on it should look three-dimensional. The image can be zoomed and contrast stretched. If the 3-D effect works, and if the scene is rectangular (e.g. not distorted with curved edges as if it were heavily warped), the epipolars are ok. If not, you may have bad TPs, too many TPs, or some other problem with the mathematical model. If the topography looks inverted, you may have made a mistake in step c above. When you are finished with the 3-D viewing, close
the window. Save the project.

6. DEM Extraction

a.
Go back to the DEM from Stereo processing step.
b.
Click the Automatic DEM Extract ion button.
c.
At the top of the dialog box that appears will be a list of the available stereo pairs in the project. The left epipolar image should be that made from the 3N band. The right epipolar image should be that made from the 3B band. The
model status should be up-to-date.  If the model is stale, something has changed in the project (e.g. TPs/GCPs were changed, etc. or you already extracted a DEM). If something has changed, you should re-check your TPs and GCPs, perform a bundle adjustment, and re-extract epipolars.
c. Under Extraction Options is a list of essential parameters.

a.
Minimum and Maximum Elevation: Be sure to enter realistic values for the terrain in the scene. This has a significant effect on whether the extraction will be successful or a total failure. Leave a 500 m cushion on each side of the elevation range just to be sure.
b.
Use the default Failure and Background values. The Failure value will be the value assigned to image pixels that do not correlate. The Background value will be assigned to non-image pixels (e.g.the black border around the image).
c.
Use 2 for the Pixel Spacing. This will create a 30-m resolution DEM.   Extracting the DEM at the full image resolution (1-pixel spacing, 15-m ground resolution) does not typically give good results.
d.
DEM Detail should be set to High.
e.
Say Yes to Fill Holes and Filter. This does some amount of pre-processing (interpolation and smoothing) to the extracted DEM. Further, manual processing will be done in a later step.
f.
Say No to Score Channel. The score channel is an image channel created wherein the value of each pixel is the success of the image correlation between the 3B and 3N images at that point. It is useful for gauging the success of the DEM extraction, but a bug in OrthoEngine causes a minor problem in a later step if the score channel is present.
e.
Under DEM, browse the filesystem for the correct location in which to save the DEM (e.g. your dem directory), and give it a name. Use the *.pix suffix. Use the same path and name - but with the *.rpt suffix - for the report filename.
f.
Save the project.
g.
The DEM extraction is a relatively lengthy process. For a single ASTER scene, a 1.5 GHz Pentium 4 single-processor Windows 2000 system with 0.5 GB of RAM can perform the DEM extraction in about 1 hour. If you stitched scenes together, it will take longer (it scales roughly linearly with the number of scenes you have). With this in mind, you can either set the DEM extraction to go immediately, or at a later time. When you have decided when to begin the processing, click the Start  DEM Extraction button, saying Yes
when it asks.
h. Wait.
7. DEM Editing

a.
When the OrthoEngine finishes extracting the DEM, save the project.
b.
Go to the DEM from Stereo processing step.
c.
Click on the Manually Edit Generated DEM button.
d.
You will be asked to browse to and select the DEM you just made.
e.
In the dialog box that appears, you will see two items under Database Channels. The first item (1) contains image data (band 3N) (it is labeled as 8u e.g. 8-bit unsigned integer data). The second item (2) contains the extracted DEM (it is labeled as 32r e.g. 32-bit real data). There should be no score channel. If the score channel is there, it is in channel 2 and the DEM is in channel 3, which messes things up a bit. Get rid of the score channel using the File -> File Utility.
f.
Click the button labelled 1. Highlight the image channel. A 1 should appear in the adjacent box. Click the button labelled 2. Highlight the extracted DEM channel. A 2 should appear in the adjacent box. (Clicking Default will do this automatically.)
g.
Click the Load and Close button.
h. Two windows appear, a dialog box and an image window. The image window shows the DEM. It can also show the image if you manipulate one of the pull-down menus. The other buttons/menus control the zoom, the contrast stretch, and the cursor color.
i. Clicking and moving the mouse around the image allows you to examine the data. At the bottom of the image window are the x and y positions of the cursor, the elevation value (read from whatever is in channel 2 of the DEM *.pix file, which is why the score channel is troublesome), and the gray level of the pixel displayed under the cursor.
j. Typically OEMs will have holes of failed values where the correlation didn't work, usually because of clouds and their shadows. Failed areas should have -100 values. Background values (the black margin around the DEM) should be -150. These values should also be automatically displayed in the dialog box. If they aren't, enter them manually.
k. Our goal in editing is to fill each failed pixel with either the background value or an elevation value. In addition, we want to remove as much noise and speckle as reasonably possible. There are several masking and filtering functions to accomplish this.
a.
Begin with large failed or garbage elevation areas. Mask these out and set their values to the background value. Interpolating across them is pointless. The exception may be large failed/garbage areas in flat,
simple terrain that could be filled reasonably. Excessive expanses of failed pixels, however, may suggest going back and trying the extraction step over (with better/more/different TPs/GCPs).
b.
Small failed areas can be masked out, set to the failure value, and then interpolated across with the Interpolate filter. Alternatively, you can fill them with a single value with the Area Fills Under Mask options.
c.
Examine the DEM carefully, toggling back and forth between it and the image channel.   Look for clusters of pixels with anomalous elevations. These spikes are like anti-holes. Mask them out, set them to the failure value, and interpolate across them/fill them. Or set them to the background value, as appropriate.
d.
Once all the failed and garbage areas are dealt with (and every pixel has either an elevation or is background), apply the Noise Removal filter twice to the entire DEM to set statistically anomalous pixels to the failure value.
e.
Apply the Erode Holes filter to the entire DEM once. This filter examines the edges around the newly-created failed pixels. If they fail a statistical test, they are also set to failure. The idea is that the pixels adjacent to the statistical anomalies removed by Noise Removal may also be unreliable. Note that although steps d-e add failed pixels to the DEM, none of the failure areas at this point is likely to be larger than a few pixels.
f.
Apply Interpolate to the entire DEM once to fill the failed areas with elevation values.
g.
Apply the Smooth filter three times to the entire DEM.
h. To save the edited DEM, click the Save DEM Back to File button. The first time, you will be asked if you want to save the edited DEM to a separate channel in the file containing the original, extracted DEM. Say Yes. You will be prompted to provide a name and description for the new channel.
i. Close the dialog box and image window and save the project when editing is complete.
8. DEM Geocoding

a.
Select the DEM from Stereo processing step.
b.
Click the Geocode Extracted DEM button.
c.
Under Input DEM, browse the filesystem for the DEM file containing the edited DEM. Click the Select button to browse the channels within the file. Highlight the edited DEM channel and click Accept. Enter the appropriate Failure and Background values.
d.
Under Output DEM, browse the filesystem for the directory in which you want to save your nearly-completed (extracted, edited, and geocoded) ASTER DEM (e.g. your dem directory). Name the new file. Enter 15m for the Pixel Spacing. Select No for Interpolate Failure Pixels.
e.
Press the Geocode DEM button to proceed. This step will take a couple of minutes to complete.
f.
When geocoding is complete, click Close, and save the project.
g.
Select the DEM from Stereo processing step, and click on the Manually Edit Generated DEM button. We will apply one last editing filter before finishing.
h. Open the newly created geocoded DEM file.
i.   There should be only one channel. Load it in channel 2.
j.   Apply the Median Filter to the entire DEM. You may want to mask out specific areas of the DEM with high-frequency noise (particularly prevalent in flat areas wherein the source image comprises swaths of uniform color), and apply this filter several times to the masked area, k. Save the DEM. Do not save it to a new channel. 1.   Close the editing dialog box and the image window, m. Save the project, n. The ASTER DEM is complete. The result can be viewed with File   -> Image View. The file can also be seamlessly read into ENVI for further analysis, registration, etc.
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